CERCLA Overview

The Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), commonly known as Superfund, was enacted by Congress on December 11, 1980. This law created a tax on the chemical and petroleum industries and provided broad Federal authority to respond directly to releases or threatened releases of hazardous substances that may endanger public health or the environment. Over five years, $1.6 billion was collected and the tax went to a trust fund for cleaning up abandoned or uncontrolled hazardous waste sites. CERCLA:

- established prohibitions and requirements concerning closed and abandoned hazardous waste sites;
- provided for liability of persons responsible for releases of hazardous waste at these sites; and
- established a trust fund to provide for cleanup when no responsible party could be identified.

The law authorizes two kinds of response actions:

- Short-term removals, where actions may be taken to address releases or threatened releases requiring prompt response.
- Long-term remedial response actions, that permanently and significantly reduce the dangers associated with releases or threats of releases of hazardous substances that are serious, but not immediately life threatening. These actions can be conducted only at sites listed on EPA's National Priorities List (NPL).

CERCLA also enabled the revision of the National Contingency Plan (NCP). The NCP provided the guidelines and procedures needed to respond to releases and threatened releases of hazardous substances, pollutants, or contaminants. The NCP also established the NPL.

CERCLA was amended by the Superfund Amendments and Reauthorization Act (SARA) on October 17, 1986.

U.S. House of Representatives U.S. Code - Title 42
Superfund

Basic Information

What is Superfund?

Superfund is the name given to the environmental program established to address abandoned hazardous waste sites. It is also the name of the fund established by the Comprehensive Environmental Response, Compensation and Liability Act of 1980, as amended (CERCLA statute, CERCLA overview). This law was enacted in the wake of the discovery of toxic waste dumps such as Love Canal and Times Beach in the 1970s. It allows the EPA to clean up such sites and to compel responsible parties to perform cleanups or reimburse the government for EPA-lead cleanups.

How Superfund Works

The Superfund cleanup process is complex. It involves the steps taken to assess sites, place them on the National Priorities List, and establish and implement appropriate cleanup plans. This is the long-term cleanup process. In addition, the Agency has the authority

- to conduct removal actions where immediate action needs to be taken;
- to enforce against potentially responsible parties;
- to ensure community involvement;
- involve states;
- and ensure long-term protectiveness.

The blueprint for these activities is the National Oil and Hazardous Substances Pollution Contingency Plan (NCP), a regulation applicable to all federal agencies involved in responding to hazardous substance releases.

Over the past 20+ years, we’ve located and analyzed tens of thousands of hazardous waste sites, protected people and the environment from contamination at the worst sites, and involved others in cleanup.

Who Implements Superfund

EPA’s Office of Solid Waste and Emergency Response (OSWER) in Washington, D.C. oversees the Superfund program. The Office of Emergency Management within OSWER is responsible for short term responses conducted under the authority of Superfund. The Office of Superfund Remediation and Technology Innovation, and the Federal Facilities Response and Reuse Office, also within OSWER, have the lead for managing the long-term Superfund response program, the latter for responses involving Federal Facilities. In addition, OSWER manages the federal Brownfields program.

Regions

EPA’s 10 Regional offices around the nation

Partnerships

EPA’s Superfund Program attempts to get
are responsible for implementing many of EPA’s programs, including Superfund. For interested parties and other stakeholders involved as much as possible, as early as possible.

Superfund Partners

Region 1--ME NH VT MA RI CT
Region 2--NY NJ PR VI
Region 3--PA DE DC MD VA WV
Region 4--KY TN NC SC MS AL GA FL
Region 5--MN WI IL MI IN OH
Region 6--NM TX OK AR LA
Region 7--NE KS IA MO
Region 8--MT ND WY SD UT CO
Region 9--CA NV AZ HI
Region 10--WA OR ID AK

Regional Superfund Contacts
Regional Public Liaisons

Superfund Help: Acronyms | Topics | Frequent Questions | Publications | Sitemap


EPA Home | Privacy and Security Notice | Contact Us

Last updated on Wednesday, June 3rd, 2009.
http://epa.gov/superfund/about.htm

Print As-Is

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.
Superfund

Laws, Policy and Guidance

Statutes

CERCLA
The Comprehensive Environmental Response, Compensation and Liability Act of 1980, known as Superfund, was enacted to address abandoned hazardous waste sites in the U.S. The law has subsequently been amended, by the Superfund Amendments and Reauthorization Act of 1986 (SARA), and the Small Business Liability Relief and Brownfields Revitalization Act of 2002.

Full Text of CERCLA, as amended.

Oil Pollution Act of 1990
The Oil Pollution Act of 1990 provides authority to respond to spills of oil.

EPA Oil Program

Regulations

National Contingency Plan (NCP)
The National Oil and Hazardous Substance Pollution Contingency Plan (NCP) is the regulation that implements CERCLA and the Oil Pollution Act under the response program. It provides the blueprint for responding to both oil spills and hazardous substances releases.

Subpart O
The Subpart O regulation applies to CERCLA-authorized grants to States. It complements EPA's general financial assistance regulation and establishes requirements for Superfund cooperative agreements and Superfund States Contracts (SSCs) that are specific requirements under CERCLA. This regulation outlines use and payment of state cost sharing requirements in the Superfund program.

All Appropriate Inquiries
The All Appropriate Inquiries regulation establishes federal standards for the conduct of all appropriate inquiries into previous ownership, uses and environmental conditions of a property for purposes of qualifying for certain landowner liability protections under CERCLA.

Policy and Guidance

Key Policies and Guidelines
Key EPA guidance documents that describe processes and procedures the Superfund program follows.

**Superfund Cleanup Process**
- Superfund Enforcement Policy and Guidance
- Preliminary Assessment/Site Inspection
- Hazard Ranking System (HRS) Scoring
- National Priorities List (NPL) Site Listing Process
- Remedial Investigation/Feasibility Study
- Records of Decision
- Remedial Design/Remedial Action
- Construction Completion
- Post Construction Completion
- National Priorities List (NPL) Deletion

**Superfund Site Activities**
- Contaminated Media, Human Health and Environmental Effects
- PRP Search and Information Requests
- Contracts and Agreements
- Enforcement
- Worker Health and Safety
- Institutional Controls
- Community Involvement
- Risk Assessment
- Site Reuse/Redevelopment
- Federal Facilities

**Superfund Help:** Acronyms | Topics | Frequent Questions | Publications | Sitemap

OSWER Home | Superfund Home | Innovative Technologies Home

EPA Home Notice | Privacy and Security Contact Us

Last updated on Wednesday, June 3rd, 2009.
http://epa.gov/superfund/policy/index.htm
Print As-Is

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.
The Superfund cleanup process begins with site discovery or notification to EPA of possible releases of hazardous substances. Sites are discovered by various parties, including citizens, State agencies, and EPA Regional offices. Once discovered, sites are entered into the Comprehensive Environmental Response, Compensation, and Liability Information System (CERCLIS), EPA's computerized inventory of potential hazardous substance release sites (search CERCLIS for hazardous waste sites). Some sites may be cleaned up under other authorities. EPA then evaluates the potential for a release of hazardous substances from the site through these steps in the Superfund cleanup process. Community involvement, enforcement, and emergency response can occur at any time in the process.

EPA Cleanup
For more information please visit EPA's Cleanup page.

Cleanup Process
- PA/ SI
- NPL Listing
- RI/ FS
  - Scoping
  - Site Characterization
  - Development and Screening of Alternatives
  - Treatability Investigations
  - Detailed Analysis
- ROD
- RD/RA
- Construction Completion
- Post Construction Completion
- NPL Delete
- Reuse

Preliminary Assessment/Site Inspection
Investigations of site conditions. If the release of hazardous substances requires immediate or short-term response actions, these are addressed under the Emergency Response program of Superfund.

National Priorities List (NPL) Site Listing Process
A list of the most serious sites identified for possible long-term cleanup.

Remedial Investigation/Feasibility Study
Determines the nature and extent of contamination. Assesses the treatability of site contamination and evaluates the potential performance and cost of treatment technologies.

Records of Decision
Explains which cleanup alternatives will be used at NPL sites. When remedies exceed 25 million, they are reviewed by the National Remedy Review Board.

Remedial Design/Remedial Action
Preparation and implementation of plans and specifications
for applying site remedies. The bulk of the cleanup usually occurs during this phase. All new fund-financed remedies are reviewed by the National Priorities Panel.

**Construction Completion**
Identifies completion of physical cleanup construction, although this does not necessarily indicate whether final cleanup levels have been achieved.

**Post Construction Completion**
Ensures that Superfund response actions provide for the long-term protection of human health and the environment. Included here are Long-Term Response Actions (LTRAs), Operation and Maintenance, Institutional Controls, Five-Year Reviews, Remedy Optimization.

**NPL Delete**
Removes a site from the NPL once all response actions are complete and all cleanup goals have been achieved.

**Site Reuse/Redevelopment**
Information on how the Superfund program is working with communities and other partners to return hazardous waste sites to safe and productive use without adversely affecting the remedy.

**Superfund Help:** Acronyms | Topics | Frequent Questions | Publications | Sitemap

OSWER Home | Superfund Home | Innovative Technologies Home

EPA Home | Privacy and Security Notice | Contact Us

Last updated on Wednesday, June 3rd, 2009.
http://epa.gov/superfund/cleanup/index.htm

This document will now print as it appears on screen when you use the File » Print command.
Use View » Refresh to return to original state.
The National Priorities List (NPL) is the list of national priorities among the known releases or threatened releases of hazardous substances, pollutants, or contaminants throughout the United States and its territories. The NPL is intended primarily to guide the EPA in determining which sites warrant further investigation.

From this Web page you will find the following information:

- **Basic Information** - Provides details about the process of adding sites to the NPL including an introduction to the Hazardous Ranking System (HRS), information on how sites are placed on the NPL, the public comment process, how sites are deleted from the NPL, and the notice of policy change for partial deletions from the NPL.

- **Where You Live** - Provides information on NPL sites in your Region through Regional links, or searching your community with either Bing™ Maps, the Google Maps™ mapping service, or Yahoo! Maps to view NPL sites and site information.

- **NPL Site Status Information** - Provides links to pages containing total counts of NPL sites that have achieved a certain status or milestone as of today and by fiscal year. Lists of all current proposed, final, construction complete, partially deleted, and deleted sites (sorted by action date, site name, or state) are also linked from this page.

- **HRS Toolbox** - Links to current guidance documents that may be used to determine if a site is a candidate for inclusion on the National Priorities List.

- **Current NPL Updates: New Proposed & New Final NPL Sites** - Links to documents for the current New Proposed and New Final sites to the NPL, including: Documentation Records, Site Listing Narratives, Support Documents and other supporting documentation.

- **Federal Register Notices for NPL Updates** - Links to Federal Register notices for Proposed and Final sites from 1982 to present.

The following table shows the number of Federal and general sites for each status and milestone as of December 10, 2009:

<table>
<thead>
<tr>
<th>Status</th>
<th>Non-Federal (General)</th>
<th>Federal</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Proposed Sites</td>
<td>58</td>
<td>5</td>
<td>63</td>
</tr>
<tr>
<td>Final Sites</td>
<td>1112</td>
<td>158</td>
<td>1270</td>
</tr>
<tr>
<td>Deleted Sites</td>
<td>325</td>
<td>15</td>
<td>340</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Milestone</th>
<th>Non-Federal (General)</th>
<th>Federal</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>Partial Deletions</td>
<td>37</td>
<td>15</td>
<td>52*</td>
</tr>
</tbody>
</table>

http://epa.gov/superfund/sites/npl/index.htm
<table>
<thead>
<tr>
<th>Construction</th>
<th>1016</th>
<th>65</th>
<th>1081</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completions</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Sites that have achieved these milestones are included in one of the three NPL status categories.

* 63 partial deletions have occurred at these 52 sites.
The U.S. Environmental Protection Agency (EPA) has revised the Hazard Ranking System (HRS) in response to the Superfund Amendments and Reauthorization Act of 1986 (SARA). The HRS is the scoring system EPA uses to assess the relative threat associated with the release or potential release of hazardous substances from a waste site. The HRS score is the primary criterion EPA uses to determine whether a site should be placed on the National Priorities List (NPL). The NPL identifies sites that warrant further investigation to determine if they pose risks to public health or the environment. Sites on the NPL are eligible for long-term “remedial action” financed under the Comprehensive Environmental Response, Compensation, and Liability Act of 1980 (CERCLA), as amended by SARA. SARA authorizes a “Hazardous Substances Superfund” totalling $8.5 billion over 5 years to pay costs not assumed by those responsible for problems at a site. The HRS uses data that can be collected relatively quickly and inexpensively, thus allowing most Superfund resources to be directed to remedial actions at sites on the NPL.

Summary of Revisions

The revised HRS retains the same cutoff score and basic approach as the original HIRS, while incorporating SARA requirements as well as improvements identified as necessary by EPA and the public. The revised HRS retains the ground water, surface water, and air pathways, drops the direct contact and fire/explosion pathways, and adds a fourth pathway, soil exposure.

Several key provisions of the revised HRS make it more comprehensive. They:

! Evaluate new exposure pathways or threats that assess direct contact of people with contaminated soils, and contamination of the aquatic food chain.

! Expand how toxicity is evaluated, considering not only acute health effects, but also carcinogenic and chronic noncarcinogenic effects.

! Increase the sensitive environments considered from just wetlands and endangered species to environments designated by various Federal and State agencies.

! Evaluate the potential for air to be contaminated and for contaminated ground water to enter surface water.

Other provisions make the revised HRS more accurate. They:

! Allow use of concentration data to determine the quantity of waste at a site.

! Assign higher scores when people are actually exposed to contamination than when they are potentially exposed.

! Assign higher scores to potentially exposed people and sensitive environments closest to a site, with scores decreasing as distance from a site increases.

The complexity and scope of the issues involved in revising the HRS required EPA to get widespread input. EPA sought information from a number of sources such as its Science Advisory Board and, on three occasions, requested public comment: before drafting the revisions, after proposing the revisions in the Federal Register, and after publishing a Field Test report describing how the revisions scored actual hazardous waste sites. These procedures generated over 2,500 comments (from approximately
145 commenters). The majority of the commenters believed that the revised HRS represented an improvement over the original HRS. Other commenters, however, believed that the data required were too extensive for a screening tool and raised numerous technical issues. EPA made significant changes based on these comments, as well as on the Field Test. The result is a revised HRS that is a practical and effective tool in identifying the nation’s worst hazardous waste sites.

**Sara Requirements**

SARA required that EPA modify the HRS so that, “to the maximum extent feasible, [it] accurately assesses the relative degree of risk to human health and the environment posed by sites.” Several specific requirements were spelled out.

**Section 105 required EPA to:**

- Assess human health risks associated with contamination or potential contamination of surface waters, either directly or as a result of run-off. This assessment should take into account the use of these waters for recreation and the potential migration of any contaminant through surface water to downstream sources of drinking water.
- Evaluate damage to natural resources that may affect the human food chain.
- Assess contamination or potential contamination of ambient air.

**Section 118 required EPA to:**

- Give a high priority to sites where contamination has resulted in the closing of drinking water wells, or has contaminated a principal drinking water supply.

**Section 125 required EPA to:**

- Revise the HRS to assure appropriate consideration of sites that contain substantial volumes of wastes described in Section 3001(b)(3)(A)(i) of the Solid Waste Disposal Act, also known as the Resource Conservation and Recovery Act (RCRA). These wastes include fly ash, bottom ash, slag, and waste from control of flue gas emissions, all generated primarily by combustion of coal or other fossil fuels. The assessment must consider:
  - Quantity, toxicity, and concentrations of hazardous constituents present in such wastes.
  - Extent of, and potential for, release of such constituents into the environment.
  - Degree of risk to human health and the environment posed by such constituents.

**Original HRS**

The original HRS used a structured value analysis approach to scoring site. This approach assigned numerical values to factors that relate to or indicate risk based on conditions at the site. The factors were grouped into three categories -- observed release/route characteristics, waste characteristics, and targets -- and were combined to obtain category scores. Each category had a maximum value, as did each component factor.

The category scores in the original HRS were then multiplied together within each of the migration pathways (ground water, surface water, and air) and normalized to obtain a pathway score. Finally, the scores for the three pathways (gw, sw, a) were combined using a root-mean-square approach. The final HRS score was the square root of the sum of the squares of the pathway scores divided by a factor, 1.73, which put all final scores on a scale of 0-100.

$$HRS = \sqrt{S_w^2 + S_a^2 + S_{gw}^2}$$

1.73

If all migration pathway scores were low, the HRS score was low. However, the HRS score could be relatively high even if only one pathway score was high. This was an important requirement for HRS scoring because some extremely dangerous sites pose threats through only one migration pathway. For example, buried leaking drums of hazardous...
substances could contaminate drinking water wells but -- if the drums were deep enough and the substances not very volatile -- not surface water or air.

Revised HRS

A number of major changes from the original HRS involve more than one of the four pathways. They are summarized before the individual pathways are discussed.

Structure. The revised HRS retains the three migration pathways. An EPA analysis of remedial actions at NPL sites indicates that some significant risks from direct contact may not have been completely addressed by removal actions, and these risks should be of concern in determining priorities for remedial action. Therefore, a fourth pathway, soil exposure (named onsite exposure in the proposed revisions), is now included in the total site score. The pathway assesses direct human exposure to hazardous substances or contaminated soil. The direct contact and fire/explosion pathways have been deleted.

The essential structural features of the revised HRS generally remain the same as those of the original HRS -- that is, relative risks continue to be evaluated using pathways, three factor categories (likelihood of release, waste characteristics, and targets), and factors -- and the score is calculated similarly.

\[ \text{HRS} = \sqrt{\frac{S_1^2 + S_2^2 + S_3^2 + S_4^2}{4}} \]

Every factor has been revised or is new in the revised HRS. A few factors have been eliminated, either because they did not discriminate among sites or because they were replaced by more accurate measures.

Key changes were made in the waste characteristics factor category; the hazardous waste quantity factor is now multiplied by toxicity and other factors, instead of being added as they were in the original HRS. This is one of several changes that make the revised HRS more consistent with risk assessment principles.

**Observed Release.** The original HRS scored an observed release if the measured concentration of the hazardous substance was significantly above the background level and if that concentration could reasonably be attributed to the site. EPA is retaining this approach to scoring observed releases in all four pathways but has incorporated criteria for determining when a release is significantly above background.

**Hazardous Waste Quantity.** Hazardous wastes, in addition to including hazardous substances, almost always include nontoxic substances. When the original HRS was developed, EPA judged that the cost during initial investigations (preliminary assessments and site inspections) of reliably determining the amount of hazardous constituents within the hazardous waste was prohibitive and, in some cases, not feasible. Therefore, the original HRS used the total quantity of waste containing hazardous substances (as defined in CERCLA Section 101), excluding any wastes that were contained so that they could not migrate.

The revised HRS uses a tiered approach to determine the hazardous waste quantity factor. Hazardous constituent concentration data, mass of Waste as deposited, volume, or surface area of the source can be used. This approach provides the flexibility to use the best data available.

**Toxicity.** Toxicity, a factor in the waste characteristics category for all four pathways, is intended to represent the relative potential of a substance to cause adverse health effects.

The original HRS assigned a toxicity factor value from 0 to 3 based on the toxicity ratings developed by N.I. Sax or the National Fire Protection Association rating scheme. Both ratings primarily emphasized acute toxicity of a substance. However, EPA's experience has been that adverse health effects at hazardous waste sites may result from carcinogenic and chronic noncarcinogenic exposures as well as acute exposures.

The revised HRS evaluates three measures of toxicity in a tiered approach that uses acute data only when the other data are not available. The three measures are:

1. Cancer risks based on two factors that
EPA's Carcinogen Assessment Group has developed for a variety of substances:

- Cancer potency factors (also referred to as slope factors) derived from experimental animals or human epidemiologic data, if available.

- Qualitative weight-of-evidence – that is, the overall strength of the data indicating potential carcinogenicity.

- Noncancer effects of chronic exposure, based on verified Reference Doses (RfDs), the estimated amount of a substance to which the human population (including sensitive subgroups) can be exposed on a daily basis over a lifetime without an appreciable risk of harmful noncancer effects. RfDs undergo a formal EPA-wide review and verification.

- Acute toxicity, based on the LD_{50} or LC_{50} (lethal dose or lethal concentration at which 50 percent of experimental animals exposed die).

**Targets (People and Sensitive Environments).** In the original HRS, the people actually exposed to contamination did not count more than those potentially exposed, nor was the level of exposure considered. To assess risks more accurately, the revised HRS gives greater weight to actual exposures by:

- Adding factors to the ground water, surface water, and air pathways reflecting risks to the nearest exposed individual -- that is, the person who is closest to the site and so is expected to be exposed to the highest concentration of contaminants.

- Giving greater weight to people whose drinking water is contaminated (or, for the soil exposure pathway, people living, working, or going to school on contaminated soil). The evaluation of exposed target populations in both the ground water and surface water pathways includes a weighting factor based on the Federal primary drinking water standards, or some other health-based benchmark if no standard exists.

- Giving greater weight in the surface water pathway to actual contamination of the aquatic human food chain.

Where no actual exposure has been documented, the people potentially exposed are distance weighted in the ground water and air pathways and dilution weighted in the surface water pathway.

The revised HRS also replaces the use factor of the original HRS with a more comprehensive resources factor that considers recreational and other uses in the ground water, surface water, and air pathways.

**Environmental Threats.** In developing the original HRS, EPA decided, given the need to set priorities for the spending of limited monies, to place greater weight on sites that posed threats to public health rather than to the environment. EPA's experience since then, however, suggested that a number of sites posing a serious threat to the environment were not scoring high enough to be on the NPL, and that some of the most serious threats dearly warrant remedial action. Therefore, the revised HRS gives greater weight than the original HRS to impacts on sensitive environments (wetlands, for example) in the surface water and air pathways. Sensitive environments are also considered in the soil exposure pathway. Relative risks to human health, however, are still weighted more heavily than sensitive environments. In addition, the revised HRS expands significantly the types of sensitive environments evaluated at a site.

**Radionuclides.** The revised HRS includes a special section (Section 7) on scoring radionuclides that allows for a parallel evaluation of radionuclides.

**Ground Water Migration Pathway**

The ground water migration pathway in both the original and revised HRS (Figure 1) evaluates the Likelihood that hazardous substances at a site or facility will migrate through the ground below and contaminate aquifers (underground formations holding usable amounts of water) and any drinking water wells that draw on those aquifers.

The revised HRS ground water pathway has the same general structure as in the original HRS. However, every factor has been revised. The most significant revision assigns weights to the target population based on distance from the site to account for dilution in the aquifer. In addition, the area (target distance limit) in which drinking water wells are considered has been expanded. A new factor, travel time, has been added to the potential-to-release calculations. In the waste characteristics category, the mobility of each hazardous substance
is considered, rather than persistence as in the original HRS.

The original HRS did not consider the direction of ground water flow in determining which populations or environments could be affected by the migration of hazardous substances at the site. The targets category gave equal weight to the entire population drawing water within 3 miles of the site.

After evaluating several options for considering ground water or contaminant flow direction, EPA decided to retain the original system, based on cost and technical considerations. Accurately determining local flow within the target distance would require considerable expenditure of time and public funds, which EPA believes is justified only at the nation’s highest priority sites -- that is, those already on the NPL. However, where there is known contamination, the populations are weighted higher than those only potentially exposed. Thus, the revised FIRS indirectly considers direction of substance migration by assigning weights to people drinking water contaminated either above or below health-based benchmarks and by using the nearest exposed individual factor.

**Likelihood of Release.** The potential-to-release to ground water is comparable to the route characteristics/containment portion of the original HRS. EPA has made a number of changes in how potential releases are scored. In the original HRS, values for depth to aquifer, net precipitation, permeability, and physical state were added, then multiplied by the value of a fifth factor, containment. The revised HRS uses four factors:

- Containment, which measures the means

---

**Figure 1**

**Groundwater Migration Pathway**

<table>
<thead>
<tr>
<th>Original HRS</th>
<th></th>
<th>Original HRS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Likelihood of Release</strong></td>
<td>x Waste Characteristics</td>
<td>x Targets</td>
<td></td>
</tr>
<tr>
<td>Observed Release</td>
<td></td>
<td>Toxicty/Persistence</td>
<td></td>
</tr>
<tr>
<td>or Route Characteristics</td>
<td></td>
<td>Hazardous Waste Quantity</td>
<td></td>
</tr>
<tr>
<td>Depth to Aquifer of Concern</td>
<td></td>
<td>Groundwater Use</td>
<td></td>
</tr>
<tr>
<td>Net Precipitation</td>
<td></td>
<td>Distance to Nearest Well/ Population Served</td>
<td></td>
</tr>
<tr>
<td>Permeability of Unsaturated Zone</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Physical State</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Containment</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Revised HRS</th>
<th></th>
<th>Revised HRS</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Likelihood of Release</strong></td>
<td>x Waste Characteristics</td>
<td>x Targets</td>
<td></td>
</tr>
<tr>
<td>Observed Release</td>
<td></td>
<td>Toxicty/Mobility</td>
<td></td>
</tr>
<tr>
<td>or Potential to Release:</td>
<td></td>
<td>Hazardous Waste Quantity</td>
<td></td>
</tr>
<tr>
<td>Containment</td>
<td></td>
<td>Nearest Well</td>
<td></td>
</tr>
<tr>
<td>Net Precipitation</td>
<td></td>
<td>Population</td>
<td></td>
</tr>
<tr>
<td>Depth to Aquifer</td>
<td></td>
<td>Resources</td>
<td></td>
</tr>
<tr>
<td>Travel Time</td>
<td></td>
<td>Wellhead Protection Area</td>
<td></td>
</tr>
</tbody>
</table>
taken at a site to minimize or prevent releases of contaminants into ground water.

! Net precipitation, which indicates the amount of water available to infiltrate into ground water.

! Depth to aquifer, which provides a measure of the time required for a contaminant to reach the underlying aquifer.

! Travel time, which measures the potential of geologic materials to slow the migration of contaminants to aquifers.

The potential to release is the sum of the values of the first three factors multiplied by the value for containment.

**Waste Characteristics.** The waste characteristics category of the original HRS included toxicity/persistence and hazardous waste quantity factors. The method used to evaluate persistence, however, was based on biodegradability and was generally not applicable to ground water. In addition to the changes in waste quantity and toxicity, the revised HRS replaces persistence with a mobility factor reflecting the rate at which a substance migrates. Combining mobility with the revised toxicity factor allows for discrimination among highly toxic substances that migrate at very different rates.

**Targets.** The targets category reflects the population potentially at risk from an actual or potential release of hazardous substances from the site to an aquifer. The revised HRS expands the target distance limit from 3 to 4 miles. Within that limit, four factors (instead of two) are considered: nearest well, population, resources, and Wellhead Protection Area.

The nearest well is a new factor in the targets category and is evaluated by measuring the distance to the nearest drinking water well. In the original HRS, the person using the nearest well was considered in a matrix with population. The two are now separate factors.

The second factor, population, indicates the number of people actually or potentially at risk from exposure to hazardous substances in drinking water wells. In the original HRS, all the people who drank water from wells within 3 miles of the site were counted equally. The total population was then combined in a matrix with distance to the nearest well to assign a single value. The revised HRS separates these factors to more clearly reflect individual risks and resource value/population risk. Population served is the sum of three groups:

! People exposed to contamination above health-based benchmarks -- for example, Federal drinking water standards.

! People exposed to contamination not above health-based benchmarks but significantly above background.

! People potentially exposed, weighted for distance.

The resources factor, a more comprehensive measure, has replaced the ground water use factor in the original HRS.

The presence of a Wellhead Protection Area, as designated under Section 1428 of the Safe Drinking Water Act, is a new factor in the targets category score. This revision addresses SARA Section 118, which requires a high priority for sites affecting principal drinking water supplies. Wellhead Protection Areas are defined as areas around a well or well field supplying a public water system through which potentially harmful contaminants are likely to move toward and reach the well or well field.

**Surface Water Migration Pathway**

The surface water migration pathway in both the original and revised HRS (Figure 2) evaluates the likelihood that runoff containing hazardous substances from a site can move through surface water and affect people or the environment. The revised HRS differs from the original HRS in several ways. The revised HRS:

! Replaces route characteristics with two potential-to-release components -- overland flow/flood and ground water to surface water. If both components are scored, the pathway score is the higher of the two scores.

! Divides the surface water pathway into three subpathways representing threats to drinking water, the human food chain, and the environment. The surface water migration pathway score is the sum of the scores of the three subpathways. This change in structure provides a relatively simple way to account for the different substances and targets that may be important for the different types of potential exposure in the subpathways.
Figure 2

Surface Water Migration Pathway

Original HRS

Likelihood of Release \times\ Waste Characteristics \times\ Targets

- Observed Release
- Route Characteristics
  - Facility Slope/Intervening Terrain
  - 1-Year, 24-Hour Rainfall
  - Distance to Nearest Surface Water
  - Physical State
  - Containment

- Toxicity/Persistence
- Hazardous Waste Quantity
- Surface Water Use
- Distance to Sensitive Environment
- Population Served/Distance to Nearest Intake
- Downstream

Revised HRS

Likelihood of Release:

Overland/Flood Component

- Observed Release
- Potential to Release
  - By Overland Flow:
    - Containment
    - Runoff
    - Distance to Surface Water
  - By Flood:
    - Containment
    - Flood Frequency

Ground Water to Surface Water Component

- Observed Release
- Potential to Release
  - Containment
  - Net Precipitation
  - Depth to Aquifer
  - Travel Time

Drinking Water Threat

Waste Characteristics \times\ Targets

- Toxicity/Persistence/Mobility
- Hazardous Waste Quantity
- Nearest Intake
- Population Resources

+ Human Food Chain Threat

Waste Characteristics \times\ Targets

- Toxicity/Persistence/
  - Bioaccumulation/Mobility
- Hazardous Waste Quantity
- Food Chain Individual
- Population

+ Environmental Threat

Waste Characteristics \times\ Targets

- Ecosystem Toxicity/Mobility
- Sensitive Environments

*Mobility, applicable only to Ground Water to Surface Water Component.
Extends the distance to the targets at risk from the probable point where hazardous substances enter the probable water to a point 15 miles from the source (versus 3 miles downstream of the farthest observed contamination, or 1 mile in static water, in the original HRS). The target values are modified by dilution weighting -- that is a lower value is assigned to a larger body of water because the substance is more diluted.

**Drinking Water Threat.** The drinking water threat in the revised HRS retains the waste quantity and toxicity/persistence factors of the original HRS but evaluates them differently. Persistence is no longer based solely on biodegradation but on four additional decay processes (hydrolysis, photolysis, volatilization, and free-radical oxidation). For each hazardous substance in (or likely to be in) surface water, a persistence value is assigned that reflects the time the substance remains in the surface water. The substance with the highest toxicity/persistence value is used, along with the hazardous waste quantity, in calculating the waste characteristics score.

The drinking water targets category in the revised HRS retains the use and population factors of the original HRS but substantially modifies them. Instead of the four uses in the original HRS use factor, with only the highest assigned a value, two uses (drinking water and other uses) are assigned values, providing a better evaluation of the risk to the resource. The distance to a surface water intake in the original HRS has been replaced with a nearest intake factor that is evaluated separately and is based on dilution at the nearest intake. As in the revised ground water pathway, the population served is evaluated in three groups based on actual and potential exposure. The population potentially exposed is weighted based on dilution.

**Human Food Chain Threat.** SARA Section 105(a)(8)(A) requires EPA, in revising the HRS, to consider the effects of hazardous waste sites on the human food chain. In developing the revisions, EPA determined that the most significant, measurable food chain risks involved contamination of the aquatic food chain. Therefore, the revised surface water migration pathway includes evaluation of the human food chain based on potential or observed contamination of aquatic food chain organisms.

In evaluating waste characteristics (and targets as well), a single hazardous substance is selected, on the basis of bioaccumulation potential, toxicity, and persistence, from among those known to be present at the site and available to the surface water migration pathway. Persistence is determined based on the same five decay processes as in the drinking water threat.

The targets category reflects the threat to people from consumption of fish and shellfish taken from the surface water migration pathway. Fishery use -- for example, commercial, subsistence, or sport fishing -- is evaluated to give an estimate of resource value. Population is calculated by estimating food chain products harvested from the contaminated surface water. Population is the sum of actual and potential contamination, and is determined based on bioaccumulation and annual production of each fishery in the surface water migration pathway.

**Environmental Threat.** In the surface water pathway of the original HRS, sensitive environments were assigned a value in the targets category on the basis of distance to a particular type of sensitive environment -- wetlands, for example. The revised HRS places more emphasis on environmental damage and expands the types of environments considered. Ecosystem toxicity is determined using EPA chronic water quality criteria for the protection of aquatic life (or other measures if the criteria are not available). Ecosystem persistence is evaluated as it is for the drinking water subpathway. The sensitive environments targets are weighted into groups based on ecologically-based benchmarks where sensitive environments are contaminated; otherwise, dilution factors are applied.

**Soil Exposure Pathway**

The soil exposure pathway (Figure 3) evaluates the potential threats posed by direct, physical contact with hazardous wastes or contaminated soil. It is similar to the direct contact pathway, which was scored in the original HRS but was not used to determine if a site should be on the NPL. The revised HRS evaluates the threat by looking at two groups potentially at risk -- those living on property with hazardous wastes or contaminated soils and those living nearby with access to the property. The resident population is evaluated based only on presence of contamination within the site boundary and within 200 feet of the boundary. The resident population is not evaluated on release potential, as in the other pathways, because contaminants do not have to migrate offsite for exposure to occur. Five targets are evaluated in the resident population:

- Resident individual -- a person living on, or
**Figure 3**

**Soil Exposure Pathway**
*(Revised HRS Only)*

### Resident Population Threat

<table>
<thead>
<tr>
<th>Likelihood of Exposure x Waste Characteristics x Targets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Observed Contamination</td>
</tr>
<tr>
<td>toxicity</td>
</tr>
<tr>
<td>hazardous waste quantity</td>
</tr>
<tr>
<td>resident individual</td>
</tr>
<tr>
<td>resident population</td>
</tr>
<tr>
<td>workers</td>
</tr>
<tr>
<td>resources</td>
</tr>
<tr>
<td>terrestrial sensitive environments</td>
</tr>
<tr>
<td>environments</td>
</tr>
</tbody>
</table>

### Nearby Population Threat

<table>
<thead>
<tr>
<th>Likelihood of Exposure x Waste Characteristics x Targets</th>
</tr>
</thead>
<tbody>
<tr>
<td>attractiveness/accessibility</td>
</tr>
<tr>
<td>area of contamination</td>
</tr>
<tr>
<td>toxicity</td>
</tr>
<tr>
<td>hazardous waste quantity</td>
</tr>
<tr>
<td>population within 1 mile</td>
</tr>
<tr>
<td>nearby individual</td>
</tr>
</tbody>
</table>

---

- Going to school or day care on, contaminated property.
- Resident population – people living on or going to school or day care on contaminated property.
- Workers – people working on contaminated property.
- Resources – contaminated property used for commerce, agriculture, silviculture, livestock production, or livestock grazing.
- Terrestrial sensitive environments on contaminated property – aquatic environments are considered in the surface water migration pathway.

The nearby population is evaluated on the basis of:

- Attractiveness/accessibility and area of contamination, which evaluate the likelihood of exposure.
- Population within a 1-mile travel distance

---

**Air Migration Pathway**

The air migration pathway of the revised HRS (Figure 4) has the same three categories as the original HRS, but each is revised. The original air pathway was evaluated only if an observed release of hazardous substances could be documented. As required by SARA Section 105(a)(8)(A), the revised HRS considers characteristics of the site to assess the potential for release if none has been documented. The likelihood of release is determined, as well as how many people and sensitive environments could be exposed to hazardous substances carried in the air and the inherent hazard associated with potential exposures. The potential to release by gases and particulates is evaluated separately based on:

- Containment, which assesses the ability of natural or constructed barriers to inhibit the escape of hazardous substances from a source.
Source type -- for example, containers (including tanks), contaminated soil (including land treatment), fire sites, landfills, surface impoundments, and waste piles.

Migration potential, which reflects the relative tendency of hazardous substances contained in a source to migrate.

In addition to the changes to waste quantity and toxicity in the waste characteristics category discussed earlier, the reactivity and compatibility factors in the original HRS have been deleted because they have proved not to be applicable to the vast majority of NPL sites; mobility has been added. All hazardous substances at a site are evaluated for gas mobility. Particulate mobility is evaluated based on the local climate. The two values are combined in a matrix to determine the mobility factor.

In the revised HRS, the three target factors in the original HRS -- land use, population within a 4-mile radius, and distance to a sensitive environment -- have been modified, and a factor has been added to reflect the risk to the nearest individual. The 4-mile limit for population in the original HRS has been retained, the limit for sensitive environments evaluated has been extended from 2 to 4 miles. In both cases, distance weighting factors are used to represent the reduced concentrations farther away from the site.
Additional Considerations

In the preamble to the proposed revisions to the HRS, EPA requested comment on two issues:

! The cutoff score for proposing sites for the NPL.

! The policy of scoring sites based on current conditions.

**Cutoff Score.** EPA chose an HRS score of 28.50 as a cutoff for placing sites on the NPL because it yielded an initial NPL of at least 400 sites as suggested by CERCLA, not because EPA had determined that 28.50 represented a threshold of unacceptable risks. Believing that the current cutoff score has been a useful management tool, EPA proposed that the cutoff score for the revised HRS be functionally equivalent to the original cutoff. However, EPA wanted to evaluate the practical effects of keeping the cutoff score at 28.50—that is, will that score continue to provide an appropriate set of priorities for management purposes. EPA examined several approaches for defining "equivalent to 28.50". These approaches included:

! A statistical analysis to determine what revised HRS score best corresponds to 28.50 on the original HRS.

! A determination of the percentage of potential sites in CERCLIS (EPA's inventory of potential hazardous waste sites) that score above 28-50 on the original NPL and the setting of a cutoff that yields the same percentage.

! An identification of risk levels that on the average correspond to an original HRS score of 28.50 and a determination of what revised HRS score best corresponds to that risk level.

Based on an analysis of 110 test sites, scored with both the original and revised HRS, EPA has decided not to change the cutoff score at this time because the analysis did not point to a single number as the appropriate cutoff. The field test data show that few sites score in the range of 25 to 30 with the revised HRS. EPA believes that this range may represent a true breakpoint in the distribution of site scores and that the sites scoring above the range of 25-30 are clearly the types of sites that should be captured with a screening tool.

Because the HRS is intended to be a screening tool, EPA has never attached significance to the cutoff score as an indicator of a specific level of risk from a site, nor has EPA intended to imply that "risky" and "nonrisky" sites can be precisely distinguished. Nevertheless, the cutoff score has been a successful screening tool that has allowed EPA to set priorities and to move forward with studying and, where appropriate, to clean up hazardous waste sites. The vast majority of sites scoring above 28.50 in the past have been shown to present risks.

**Scoring on the Basis of Current Conditions.** Under the original HRS, EPA generally scored the three migration pathways based on the conditions at the site before, any response action had been taken, rather than based on current conditions at the site. In revising the HRS, EPA decided that it may be appropriate to evaluate sites based on current conditions and to consider prior responses in calculating an HRS score.

The policy of evaluating sites based on current conditions raised concerns that it might:

! Encourage private parties to only take action sufficient to lower the score so the site would not be placed on the NPL.

! Discourage public agencies from taking early actions that could lower the score, thus preventing the site from being on the NPL and therefore eligible for Superfund monies.

EPA examined two approaches to incorporate current site conditions in the HRS score. Under either approach, EPA would only consider actions prior to a site inspection, which provides most of the data used to score a site. Because response action at sites may be an ongoing process, it would be burden-some to recalculate scores continually to reflect such actions. The two approaches were:

! Consideration of current conditions for certain pathways or factors where appropriate.

! Consideration of current conditions routinely, but identification of situations where initial conditions more accurately reflect risks.

EPA decided to consider response actions prior to a site inspection because it will provide increased incentives for rapid response.


Superfund Community Involvement

Community involvement is the process of engaging in dialogue and collaboration with community members.

The goal of Superfund community involvement is to advocate and strengthen early and meaningful community participation during Superfund cleanups. Superfund community involvement staffs at Headquarters and in the Regions strive to:

- Encourage and enable community members to get involved.
- Listen carefully to what the community is saying.
- Take the time needed to deal with community concerns.
- Change planned actions where community comments or concerns have merit.
- Keep the community well informed of ongoing and planned activities.
- Explain to the community what EPA has done and why.

The Superfund Process

There are several steps involved in cleaning up a Superfund site. This section contains an interactive graphic of the Superfund cleanup process. You can click on each step in the graphic to learn more about that phase of the process.

Community Resources

This section provides information about a variety of technical assistance and
training resources provided by EPA. These resources help communities fully participate in decisions at local Superfund sites. In addition, links to related are provided to EPA and other programs that also can be useful to communities with Superfund sites.

Community Involvement Policies and Guidance
This section provides access to EPA policy directives and other documents that guide EPA's community involvement efforts.

Superfund Community Involvement Publications
This section contains EPA publications for community members at Superfund sites. These publications include information about how EPA determines the risk at a site, how to get detailed reports about the site in your area, and how EPA supports reuse of sites after they have been cleaned up.
Superfund Community Involvement

The Superfund Process

There are several steps involved in cleaning up a polluted site. Once a polluted or potentially polluted site has been reported to EPA by individual citizens, state agencies, or others, EPA follows a step-by-step process to determine the best way to clean up the site and protect human health and the environment. Opportunities for community involvement occur throughout the process, which is shown in the graphic below and described in the text on this page. Click on a step to read more.

Links

Community Involvement
- Community Involvement Home
- Technical Assistance Grants (TAG)
- Community Advisory Group (CAG)
- Technical Assistance Services for Communities (TASC)
- Superfund Job Training Initiative (SuperJTI)
- Regional Public Liaison (RPL) (under development)
Preliminary Assessment and Site Investigation (PA/SI)

The preliminary assessment (PA) involves gathering historical and other available information about site conditions to evaluate whether the site poses a threat to human health and the environment and/or whether further investigation is needed. The preliminary assessment also helps identify sites that may need immediate or short-term response actions. The site investigation (SI) tests air, water, and soil at the site to determine what hazardous substances are present and whether they are being released to the environment and are a threat to human health.

Information about the site that is collected in the PA/SI phase helps EPA to evaluate the risks posed by the site using its Hazard Ranking System (HRS). Sites that score at or above an established level qualify for cleanup under the Superfund and are proposed for listing on the National Priorities List (NPL), a list of the most serious sites identified for long-term cleanup.

During the PA/SI phase, EPA may issue a notice through the local media and/or distribute a fact sheet to let the community know they are investigating the site.

**Opportunities for Community Involvement during PA/SI**

* Provide any information you have about the site to EPA.
National Priorities List (NPL) Listing Process

The NPL is a list of the most serious sites identified for long-term cleanup. When EPA proposes to add a site to the NPL, the Agency publishes a public notice about its intention in the Federal Register and issues a public notice through the local media to notify the community, so interested members of the community can comment on the proposal. EPA then responds to comments received. If, after the formal comment period, the site still qualifies for cleanup under Superfund, it is formally listed on the NPL. Once it is listed, the Agency will publish a notice in the Federal Register and respond formally to comments received. In addition, EPA may issue a fact sheet or flyer to notify the community impacted by the site.

Opportunities for Community Involvement during NPL Listing Process

- Read information about the site and EPA’s proposal to list the site on the NPL.
- Contact EPA to ask question or request additional information.
- If you have concerns about the site listing, prepare and submit comments on the proposal during the Public Comment period.

Remedial Investigation and Feasibility Study (RI/FS)

The RI/FS phase of the process determines the nature and extent of contamination at the site, tests whether certain technologies are capable of treating the contamination, and evaluates the cost and performance of technologies that could be used to clean up the site.

Prior to the beginning of the RI/FS phase, EPA will begin its outreach and community involvement efforts at the site. The Agency will appoint a Community Involvement Coordinator (CIC) for the site who will work with community members throughout the cleanup process. EPA staff will interview community members, local officials, and others to gather information about the site and the community and to learn how community members want to be involved in the cleanup process. The Agency then will prepare a Community Involvement Plan that specifies the outreach activities they will use to address the concerns and expectations community members raised in the interviews. The Community Involvement Plan is readily available to the community.

EPA will establish an Information Repository at or near the site where all correspondence, reports, and documents pertaining to the site cleanup will be stored and available to community members. In addition, EPA will issue public notices and other documents to communicate important information about the cleanup, including the potential availability of a Technical Assistance Grant (TAG) or other assistance resources to help the community understand technical information about the cleanup to better participate in decisions affecting the cleanup.

EPA will establish an Administrative Record for the site as part of the Information Repository when the RI/FS begins. The Agency will issue a public notice through the local media to notify the community about the Administrative Record. As the cleanup process moves forward, EPA will add to the Administrative Record all the relevant...
documents used in making the eventual cleanup decision, as well as relevant
documents on technologies that were considered but ultimately rejected.

To keep the community informed during this phase of the cleanup, EPA will issue
public notices through the local media and conduct public meetings.

Based on results of the feasibility study portion of this phase, EPA will develop a
Proposed Plan for cleaning up the site. The Agency will issue a public notice through
the local media to notify the community, so interested members of the community can
comment on the Proposed Plan. In addition, the Agency may hold a public meeting to
discuss the Proposed Plan. EPA then will develop a Responsiveness Summary to
formally respond to public comments received. If, based on public comments, the
Proposed Plan is changed substantially, EPA will issue an explanation of the changes
made and invite public comment on the changes.

Throughout this phase of the cleanup, EPA Community Involvement staff will be
working to keep the community informed of progress by conducting public meetings,
issuing regular fact sheets about progress at the site, conducting workshops for
community groups, and making presentations to civic groups, schools, and local
officials to help everyone better understand the cleanup process.

Opportunities for Community Involvement during the RI/FS

- Ask the CIC or the Remedial Project Manager (RPM) questions about the site.
- Read EPA’s Proposed Plan for cleaning up the site.
- Consider whether to form a Community Advisory Group (CAG).
- Consider whether your community group should apply for a Technical
  Assistance Grant (TAG).
- Consider whether your community should request help through the EPA’s
  Technical Assistance Services for Communities (TASC) contract.
- Participate in any public meetings or other EPA events on the Proposed Plan;
  ask questions; and provide comments on plans for cleanup and on the reuse
  options being considered for the site.
- If you can’t attend public meetings or other events, visit the Information
  Repository and read the Proposed Plan and other documents. Prepare and
  send any comments you have to EPA.
- Read EPA’s Responsiveness Summary to find out how the Agency plans to
  address major concerns raised in community members’ comments.
- Invite EPA to attend community events to discuss the site and the Proposed
  Plan.

Record of Decision (ROD)

The ROD explains which cleanup alternatives will be used at NPL sites. It contains
information on site history, site description, site characteristics, community
participation, enforcement activities, past and present activities, contaminated media,
the contaminants present, description of the response actions to be taken, and the
remedy selected for cleanup. The development of the ROD also includes consideration
of how the site could be used in the future.

EPA will issue a public notice through the local media to notify the community that the
ROD is available for inspection. If changing the ROD is necessary, EPA will develop a
proposed ROD amendment, issue a public notice through the local media to notify the
community, and hold a public meeting to discuss the proposed changes and to take comments. EPA then develops a Responsiveness Summary to formally respond to public comments received.

After the ROD has been completed, The CIC will revise the Community Involvement Plan for the site to ensure that it is consistent with the final ROD.

**Opportunities for Community Involvement related to the ROD**

* Inform EPA about how the community wants the site to be used in the future.
* Read the ROD for cleaning up the site.
* Participate in any public events on the ROD.
* If you can’t attend public events, visit the Information Repository and read the ROD and supporting documentation.
* Contact the CIC or RPM to ask questions or request more information.

---

**Remedial Design/Remedial Action (RD/RA)**

This phase of the process includes preparing for and doing the bulk of the cleanup at the site. EPA develops the final design for the cleanup. Throughout this phase, EPA community involvement staff will keep community members advised about the progress of the cleanup through periodic public events, newsletters, fact sheets, and presentations to civic groups, schools, and local leaders.

**Opportunities for Community Involvement during RD/RA**

* Learn about the final design for the cleanup by attending public events or reading the information EPA distributes.
* Work through your CAG, TAG recipient, or TASC provider to stay informed about the progress of the cleanup.
* Attend periodic public events about progress at the site. If you can’t attend, visit the Information Repository and read site information.
* Contact the CIC with questions or comments.
* Visit the site to observe cleanup activities.

---

**Construction Completion**

This is the point in the process when any necessary physical construction needed for the cleanup has been completed (even though final cleanup levels may not have been reached), or when EPA has determined that the site qualifies for deletion from the NPL.

---

**Post-Construction Completion**

This phase of the process ensures that Superfund cleanups provide for the long-term
protection of human health and the environment. EPA’s activities during this phase will include operating and maintaining long-term cleanup technologies in working order, regularly reviewing the site to be sure that the cleanup continues to be effective, and enforcing any necessary restrictions to minimize the potential for human exposure to contamination.

**Opportunities for Community Involvement related to the Post-Construction Completion**

- Work through your CAG or TAG to participate in and review the results of regular site reviews.
- Visit the site or arrange a site tour through EPA.
- Invite the EPA Community Involvement Coordinator for the site to your community events to discuss results of the five-year review.
- Plan an event to celebrate major milestones in the cleanup of the site.

**Deletion from the NPL**

When all site cleanup has been completed and all cleanup goals have been achieved, EPA publishes a notice of its intention to delete the site from the NPL in the Federal Register and notifies the community of its availability for comment. EPA then accepts comments from the public on the information presented in the notice and issues a Responsiveness Summary to formally respond to public comments received. If, after the formal comment period, the site still qualifies for deletion, EPA published a formal deletion notice in the Federal Register and places a final deletion report in the Information Repository for the site.

**Opportunities for Community Involvement related to NPL Deletion**

- Read EPA’s proposal to delete the site from the NPL and submit your comments to EPA.
- Read EPA’s Responsiveness Summary to find out how the Agency is addressing the public comments received.
- Read the final deletion report, which is available at the Information Repository.
- Plan a community event to celebrate deletion of the site from the NPL.

**Reuse**

Once sites have been cleaned up, EPA works with communities through an array of tools, partnerships, and activities to help to return these sites to productive uses. These uses can be industrial or commercial, such as factories and shopping malls. Some sites can be used for housing, public works facilities, transportation, and other community infrastructure. Some sites can be for recreational facilities, such as golf courses, parks and ball fields; or for ecological resources, such as wildlife preserves and wetlands. No matter what use is appropriate for a site, the community benefits from restoring the site to productivity, because the property can once again add to the economic, social, and ecological value of the community.
Opportunities for Community Involvement related to Reuse of the Site

- Work with EPA, your local government, and your neighbors to plan the redevelopment of the site.
- Explore the redevelopment tools and resources provided by EPA (http://www.epa.gov/superfund/programs/recycle/tools/an.html).
- Be supportive of redevelopment plans once they have been agreed upon.

Top of Page